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Your Life Ledger 
 

EXPLANATION OF THE LIFE LEDGER (PLEASE READ FIRST): 
 
The Life Ledger was created to accompany the 12-lesson 
course “Navigating As We Age: Changes & Choices” 
created over three years by the Riderwood Caring 
Connections Committee in Silver Spring, MD.  Specific 
sections of the ledger were designed to be filled in 
during and immediately after each lesson.  If you choose 
to use it without attending the course, please do so 
with the following understanding: 

• The ledger is a reference tool to document your 
legacy: your legal, financial, health information as 
well as your values and wishes 

• The Life Ledger is not a binding legal document or substitute for your will 
or trust 

• Some items may seem confusing without the context of the course 
• It should be updated regularly as circumstances change and no less 

frequently than once a year 
• This is an important gift that should be shared with your loved ones and 

agents 
• All fields are optional 
• If you are concerned about where to keep your Life Ledger containing 

sensitive information, please see “How to Keep Your Life Ledger Secure” 
below 

 
  



 2 

HOW DO I PUT MY OWN LIFE LEDGER ONTO MY COMPUTER? 
 

1.  Go to https://riderwoodlife.com/caring-connections/  
 

2. Scroll down the page to “Life Ledger download” and click (or double-click) on 
“Life Ledger, 2022 Edition.”  NOTE:  The word “download” only means that 
your computer will receive data temporarily from the internet.  The second part 
of the process is that you must save your download or it will disappear. 

 

 
3.  When you click on “Life Ledger, 2022 Edition,” it will open a “Save As” box 

with “Life-Ledger-2022-Edition-12-pt” already filled in the “Save As” box.   
4. Choose where to save it—the quickest place to find it is on your desktop.  Click 

on “Desktop” and either give it a different name or keep the one already in the 
“Save As” box.  Then click “Save.”  If you’re a more experienced computer 
user, you may want to create a new “Caring Connections” folder where you 
can put the Life Ledger and any other forms you want to download if you know 
how to do that. 

 
a. Security: You can rename it before you save it if you want.  For example, 

if you want to camouflage it for security, you could change the name in 
the “Save As” box to “Washington Nationals Scores” or some other 
fictitious name that you will remember—as long as you tell your family 
the title you gave it. If you want to share it with your family, you can 
create a Dropbox account if you like (it’s a free program), or email it to 
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them as an attachment.  See “How to Keep Your Life Ledger Secure” 
below. 

 
b. Mac users only: If you have Word on your Mac, use it.  However, if you 

only use the Pages program that came on your Mac, here’s the way to 
convert it to a Pages program.   

i. First, save the Word document from the RiderwoodLife.com link 
above to your computer, perhaps on your desktop.   

ii. Now open your Pages program.  
iii. Then, from the Pages program, click on the “File” tab and then 

“Open” from the drop-down menu. A directory pop-up window 
appears.  

iv. Choose the location where you saved the Life Ledger you 
downloaded (such as the desktop), click on the file (“Life Ledger”) 
and it will open in Pages.  Be sure to save it periodically as you 
work on it. 

5. Now that you have saved it on your computer, you can add all of your 
information into it.  Every time you start your computer, you will see the Life 
Ledger on your desktop.  Double-click on the icon to open it and add to it.  
Don’t forget to save your work before closing it. 
 

TIP FOR MORE ADVANCED USERS 
How to quickly get to your desktop: 

§ PC:  Windows key + D (for “desktop”) 
§ Mac:  F11 
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DEFINITIONS 
 
Cursor or pointer: the pulsing vertical line or arrow or hand that 
appears when you left-click your mouse on a page  
Mouse: the device you hold in your hand that controls the pointer 
or cursor 
Right-Click: press on the right button at the top of your mouse 
Left-Click:  Press on the left button at the top of your mouse 
 
Tables or Charts 

Cell or field: a box in any row or column in a chart or table. In 
your Life Ledger, each cell or field in a column will expand as 
you write in it. 
Column: a vertical line in a chart or table 
Row:  a horizontal line in a chart or table 
 

Download: data is transferred temporarily from the internet to 
your computer monitor so you can see it. Then you have to save it 
or it will disappear. 
Menu: a list of options you can choose from 
Drop-down menu: a list of choices that appears, or “drops down,” on 
a computer screen when you click on the menu's title. Then you can 
click on the option you want.  
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HOW DO I ADD AND DELETE INFORMATION IN MY LIFE LEDGER? 
 

1. We hope you will follow the homework schedule.  For example, Lesson 1 
asks that you fill out the “Identification and Personal Information.” You can 
do more, of course. 

2. Put your cursor or pointer (it usually looks like an arrow or hand) 
into any box (also known as a cell or field), press down on your 
mouse  (or “click”), and begin typing.  When you click inside a box, 
you may not see your cursor but you can begin typing anyway.  
For example, let’s say you are filling out the table about your 
siblings.  Compare what happens to the two tables below when I 
fill in more than nominal information—the cells automatically expand to fit 
the page.  They will also spill over onto the next page if you keep adding 
information: 

 
Chart with nominal information: 

My Siblings 
Name Address Phone Email Facebook 

or social 
media 

Date 
of 

birth 

Spouse’s 
name 

Notes 

Nan Cook Silver Spring 3015555555 None None 5/10/41 n/a   
Ron Smith Bethesda 3015551234 rsm@gmail None 6/30/43 Sue  
 
Chart with more information (note that this table spills onto the next page but 
the heading goes with it): 

My Siblings 
Name Address Phone Email Facebook 

or social 
media 

Date 
of 

birth 

Spouse’s 
name 

Notes 

Nan 
“Nancy” 
(Smith) 
Black 

3110 
Gracefield 
Rd., #712, 
Silver 
Spring, MD 

(301) 555-
5555 

nancythebest@ 
gmail.com 

None 5/10/41 Thomas 
Edison Black 

Nan and 
her 
husband 
are my 
bosom 
buddies 
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How to select text to delete: 
• Put your cursor at the beginning of what you want to delete.  Left-

click and hold down until you reach the end of what you want to 
delete, then let up the left-click. The text you selected will be 
highlighted, probably in a buff color. 

• Click on the “Delete” button and the highlighted text will disappear 

My Siblings 
Ron Smith Bethesda (301) 555-

1234 
rsm@gmail None 6/30/43 Sue Ron should 

be 
contacted 
last since 
we’re not 
really close 

Theresa 
(“Terry”) 

The Dower 
House, 
Henley-on-
Thames, 
England 

1     Only 
contact 
Terry if 
there’s an 
emergency 
since she 
lives so far 
away 

        
 
 

3. As you type, each box or cell will automatically expand vertically to 
accommodate your typing (see above).  The other columns will not be 
affected. 

4. How to skip a box or field: You can skip any box or cell by pressing the 
“Tab” key.  Your cursor will then jump to the next cell.  Or you can write 
N/A if you prefer. 

5. How to add a new row: If your cursor is in the last cell or box,  click 
“Tab” and  it will create a new row. 

 
6. How to correct any entry: You can change anything in any cell.  Just 

backspace like you do on your phone or use your mouse to select the 
mistake and retype the word or amount that should be there.  Or you can 
highlight the wrong information (see explanation in blue box below) and 
type over it.  It won’t erase the entire row, only the information you 
highlight.   
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7. How to delete all of the information in a table:  You can also delete 
everything in a chart or table by selecting all of the rows and columns and 
pressing “Delete” on your keyboard.  It won’t delete the actual table, only 
the information you entered in the chart.  For example, the “Charity List” in 
the Life Ledger contains sample entries that you will want to highlight and 
delete. See #12 below for how to delete the actual table. 

 
8. How to add a row or column: You can also add a row or column to any 

chart by putting your cursor in any cell and right-clicking.  A drop-down 
menu will appear.  Hover over “Insert” and then choose any option like 
“Columns to the right” or “Rows Below” the cell your cursor is in.  
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9. How to delete a row: You can delete any row by 
putting your cursor in any cell in the row, right-
clicking and hovering over “Delete Cells” from the 
drop-down menu (see screenshot above). Then choose 
“Delete entire row.” 

10. How to delete a column: You can delete any column 
by putting your cursor in any cell in the column, right-
clicking and choosing “Delete Cells” from the drop-
down menu and choosing “Delete entire column.” 

11.  How to get rid of blank space: Sometimes if you add lines it will go into 
the next page and leave a lot of white space until the next section.  You can 
delete the extra space by selecting/highlighting it and clicking on your 
“Delete” key. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TIP 
 

If you make a mistake, just hold down your “Control” key and type Z 
(capitalization doesn’t matter).  That will zero out (or delete) the last 
letter or word you wrote.  Your computer’s memory holds many 
(perhaps 100?) of the last edits you make in this or any other Word 
document, even if you save the document, so you can click “z” while 
holding down the Control key as many times as you like.  However, if 
you actually close Word and reopen your document, the memory will 
be gone.  Control-Z only works on documents from the time you open 
them—it’s a temporary way to retrieve your work. 
(My husband calls it the “magic key” because you can use it with the 
letter C for “Copy,” P for “Print,” S for “Save,” V for “Velcro” or paste, 
and other things) 
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12.How to delete an entire chart or table: Let’s say you don’t have any siblings 
and you want to delete that entire “My Siblings” chart. Move your cursor to 
the upper left corner at the top of the table and hover.  A small icon will 
appear (you won’t see the icon until you move your cursor to it). Right-click 
on that “table selection icon” and a drop-down menu will appear. 

 
This is a screenshot of the drop-down menu that appears after you right-click on 
the “table selection icon.”  Now choose “Delete Table” and it will disappear.  
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13.   How to add a new chart or table: There are two ways: (A) Use “Insert” on 
the Word Menu Bar  

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
Or (B) use the “Insert” on the Edit Menu, then choose “Table” which will open 
“Insert Table” where you can choose how many rows and columns you want. 
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HOW DO I MAKE NEW TABLES FIT THE PAGE 
1. Note one of the two tables in this illustration is too narrow.  Put your cursor 

in any cell of the table.  A “Table Tools” tab will open.  Click on “Layout.” 
 

 
 

2. When you click on “Layout,” you’ll see “Autofit” with a tiny arrow at the 
bottom—click on the arrow.  Then choose “AutoFit Window.” That will 
make the table expand and fit the margins of the page. 
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HOW DO I SAVE THE CHANGES I MAKE IN MY LIFE LEDGER? 

 
 
There are 3 ways to save the information you enter: 

1. At the very top you will see the Word menu.  The first word after “Word” is 
“File.”  Click on “File” and then “Save” from the drop-down menu.  This will 
save the changes you make as you change your Life Ledger. 

2. Go to “File” and choose “Save As…” from the drop-down menu.  This means 
that you are creating a new document and keeping the older version. You 
can save it with a different name and in a different place. 

3. Shortcuts:  you don’t have to use the menu at all, just hold the magic 
“Control” key and press “S” for “save.”   

a. Note: You can also paste or “Velcro” anything you want by select it 
(highlighting the text) and then copying it. Then put your cursor in 
another location, holding the magic “Control” key while you press 
“V” for “Velcro.”  You can highlight anything you want to delete and 
then press the “Delete” key. If you make a mistake, just “zero” it 
out with Control-Z.  Even if you save the document, you can still 
“zero” anything out as long as you don’t close the document.   
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HOW TO KEEP YOUR LIFE LEDGER SECURE 
 
Before you start filling out the Life Ledger, the first thing to consider is how you 
want to keep your document since it will be full of personal information. There 
are several options to choose from: 

o Option 1: Save on computer with light or no security:  If you feel 
comfortable storing it on your computer or a thumb drive without 
changing its name, do so. If you want to save it on your computer with a 
fictitious name that you (and your family) will recognize, save it with a 
name like “Washington Nationals Scores” or “Good Housekeeping 
Recipes.” 

o Option 2: Hide a printout in plain sight: If you would feel more 
comfortable hiding a printout of the Life Ledger in plain sight, make a 
cover for it to disguise it: 

1. Copy the “Montgomery Book Club Suggestions” and book image by 
putting your cursor in front of the word “Montgomery” below, 
holding the left button of the cursor down until you see the book 
image is highlighted, and then right-click and choose “copy.”  

 
Montgomery Book Club Suggestions 



 14 

Now create a new blank document in Word by clicking on “File” to 
open the drop-down menus and choose “New Document.” 

2. Put your cursor on this new blank page, right-click and choose 
“paste.”   

3. Save it on your computer by using “Save As” (give it any title as you 
save it; you can also use a different image if you know how).  

4. Print out the cover page and staple it to the front of the printed Life 
Ledger. 
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o Option 3: Save on your computer with password protection (encryption): 
o If you would like to protect your Life Ledger by adding a password to 

the document on your computer, do this (if you protect it with a 
password, be sure at least two trusted people know the password): 
PC users:  (1) Open the Life Ledger, then click on “File”    
 

 (2) Next, click on “Info”  
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(3) Next, click on “Protect Document” and then “Encrypt with Password” 
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Mac users: (1) Open Life Ledger, then choose “Review” tab, then click on  
“Protect Document”  

 
(2) When you click on “Protect Document,” a box opens that allows you to 
“Set a password to open this document” or “Set a password to modify this 
document.”   

 
(3) Type a password that you (and your family) will remember into the 
“Password” box. 
(4) Be sure to save the document. 
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If you want to decrypt the document, use the password to open it, then click 
File > “Encrypt with Password” and delete the password in the box, and click 
“OK.” Save the document. 
 

 
 


